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Abstrak - Penelitian ini adalah penelitian deskriptif kuantitatif yang 
bertujuan untuk menjelaskan valuasi sumber daya air serta pemanfaatan air 
sungai bawa tanah yang berkelanjutan di Kawasan Gua Leang Lonrong. 
Data yang digunakan data sekunder berupa data Debit Air tahun 2015-2020 
yang diperoleh dari Balai Besar Wilayah Sungai Pompengan Jeneberang 
(BBWS). Kemudian menganalisis data debit air harian untuk menghitung 
besarnya ketersediaan air di Sungai Leang Lonrong dengan menghitung 
nilai rata-rata debit air harian selama 6 (enam) tahun kemudian membuat 
plot grafik air harian pada Microsoft excel 2016. Selanjutnya melakukan 
prediksi debit air pada sumber air di Sungai Leang Lonrong untuk 
meramalkan pola yang akan datang dengan pendekatan model ARIMA 
dengan cara melakukan Uji Stasior data, mencari model ARIMA, 
melakukan pengujian ARIMA dan melakukan peramalan (prediksi) 
berdasarkan data debit air yang diperoleh untuk melihat ketersediaan Air 
Sungai Bawah Tanah di Gua Leang Lonrong. Hasil analisis debit air 
berdasarkan hasil prediksi (2021-2024) di Kawasan Gua Leang Lonrong 
memiliki debit air tertinggi pada bulan Desember tahun 2024 sebesar 4,41 
𝑚ଷ/s atau 139,1 𝑚ଷ/tahun sedangkan debit air terendah terjadi pada bulan 
September tahun 2021 sebesar 2,81 𝑚ଷ/s atau 88,63 𝑚ଷ/tahun ini 
menunjukkan bahwa keberlanjutan ketersediaan air selalu ada tiap 
tahunnya sehingga daya dukung air ditentukan oleh kemampuan 
ketersediaan air ini berarti bahwa hasil pengolahan data yang diperoleh 
tidak sesuai dengan teori ini dikarenakan debit air sungai Leang Lonrong 
dapat berubah-ubah menurut curah hujan dan keadaan biofisik DAS. 

Kata Kunci:Leang Lonrong, Wisata Mandiri, Debit Air 
 
Abstract –This research is a quantitative descriptive study that aims to 
explain the economic valuation of water resource and the sustainable use of 
underground river water in the Leang Lonrong Cave area. The data used 
are secondary data in the form of water discharge data for 2015-2016 
obtained from the Pompengan Jeneberang River Basin Center (BBWS). 
Then analyze the daily water discharge data to calculate the amount of 
water availability in the Leang Lonrong River by calculating the average 
value of daily water discharge for 6 (six) years and then making a daily 
water graph plot on Microsoft Excel 2016. Next, predict water discharge at 
water sources in Sungai Leang Lonrong to predict future patterns with the 
ARIMA model approach by conducting a data station test, looking for an 
ARIMA model, carrying out ARIMA testing and carrying out forecasting 
(predictions) based on water discharge data obtained to see the availability 
of Underground River Water in Leang Lonrong Cave .The results of the 
analysis Water discharge data based on prediction results (2021-2024) in 
the Leang Lonrong Cave Area has the highest water discharge in December 
2024 of 4,41 𝑚ଷ/𝑠 or 139,1 𝑚ଷ /year while the lowest water discharge 
occurs in September 2021 amounted to 2,81 𝑚ଷ/𝑠 or 88,63 𝑚ଷ/year, this 
shows that the sustainability of water availability always exists every year 
so that the carrying capacity of water is determined by the ability of water 
availability in accordance with this theory because the water discharge of 
the Leang Lonrong river can vary according to rainfall and the biophysical 
condition of the watershed. 
 
Keywords: Leang lonrong cave area, independent travel, water discharge 
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A. PENDAHULUAN 

Indonesia merupakan Negara yang memiliki pegunungan karst yang cukup luas, membentang 

sepanjang Pulau Jawa dan pulau-pulau lainnya. Pegunungan karst terdapat di seluruh wilayah 

kepulauan Indonesia dengan luas kurang lebih 15,4 juta hektar. Beberapa kawasan karst yang terkenal 

di Indonesia diantaranya kawasan karst Gunung Sewu (DIY, Jateng, Jatim), Karst Gombong (Jateng), 

Karst Maros-Pangkep (Sulsel), Karst Sangkulirang-Mangkaliat (Kaltim), dan kawasan Karst Gunung 

Lorentz (Papua). Kawasan Karst Maros- Pangkep di Sulawesi Selatan merupakan salah satu kawasan 

karst yang mempunyai bentang alam yang unik dan khas yang biasa disebut tower karst dan memiliki 

luas 42 Ha dan merupakan Kawasan Karst terindah kedua setelah Cina. Kawasan ini terletak di 

Kabupaten Maros Sulawesi Selatan. Kabupaten Maros hanya berjarak sekitar 30 km perjalanan dari 

Kota Makassar sehingga dapat berfungsi sebagai penyangga Kota Makassar (Sari, R. P. et al., 2019).  

Kawasan Karst ditandai dengan medium yang heterogen dan sangat rentan dengan tekanan dari 

luar. Kawasan Karst Maros-Pangkep Bantimurung Bulusaraung mempunyai kandungan batu kapur 

(𝐶𝑎𝐶𝑂ଷ) yang tinggi dan terhampar pada daerah yang luas (Palloan. et al., 2020). Kawasan ini unik dan 

kekayaannya, tidak hanya tampak pada epikarst tetapi juga endokarst yang meliputi air sungai bawah 

tanah dalam gua. Kawasan ini mempunyai kurang lebih 268 gua yang 6 di antaranya merupakan sumber 

(hulu) sungai-sungai besar di Sulawesi Selatan (Arsyad. et al., 2013). Kerapatan mata air merupakan 

indikasi terdapatnya ketersediaan debit air di bawah permukaan yang ditandai dengan keberadaan gua. 

Salah satunya adalah Gua Leang Lonrong. 

Gua Leang Lonrong terletak di Desa Panaikang Kecamatan Minasatene Kabupaten Pangkep, 

Sulawesi Selatan. Leang Lonrong adalah salah satu tempat wisata di Kabupaten Pangkep yang memiliki 

potensi keindahan alam dan sumber daya air yang dapat dikembangkan sebagai tujuan ekowisata (Nur 

Hayati, 2019). Sistem hidrologi karst menjadikan minimnya akumulasi cadangan air permukaan yang 

dapat dimanfaatkan, tetapi disisi lain hilangnya air permukaan dan aliran permukaan yang langsung 

masuk ke dalam tanah menjadikan akuifer karst memiliki potensi sumberdaya air yang cukup tinggi 

terutama dari segi kuantitas. Ketersediaan air yang ada di dalam tanah ini bisa dikatakan sebagai 

cadangan air tanah pada bentuk lahan karst (Agniy. et al., 2017). 

Sungai bawah tanah merupakan hasil bentukan proses pelarutan, terbentuknya sungai bawah tanah 

tidak lepas dari terbentuknya gua-gua karst. Gua merupakan bentukan rongga kosong di bawah tanah 

hasil pelarutan batuan dengan ukuran yang cukup besar sehingga memungkinkan manusia untuk bisa 

memasukinya. Keberadaan Gua-gua karst yang saling terhubung satu sama lain menjadikan sebagai 

system perguaan, kemudian system perguaan ini Ketika terisi oleh air maka menghasilkan sungai bawah 

tanah (Kusumayudha,2005). 

Pariwisata dapat menimbulkan tekanan terhadap lingkungan, karena pariwisata membutuhkan 

sumber daya lingkungan untuk menopang keberlangsungan pariwisata. Sumber daya air menjadi 

pendukung utama keberadaan pariwisata di suatu wilayah (Kusumawati,2016). Daya dukung air 
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ditentukan oleh kemampuan ketersediaan air. Pertumbuhan pariwisata diikuti dengan pertumbuhan 

kebutuhak akan sumber daya lingkungan untuk mendukung keberadaaan pariwisata. Air menjadi 

kebutuhan penting untuk industru pariwisata, tanpa air mustahil pariwisata bisa berjalan. Pariwisata 

menimbulkan dampak terhadap lingkungan khususnya daya dukung air. (Sudipa. et al. 2020) 

Menurut, Arsyad, M. (2013) melakukan penelitian mengenai ketersediaan debit air sungai bawah 

tanah di Kawasan karst Pangkep. Dari hasil penelitian diperoleh ketersediaan debit air sungai bawah 

tanah bergantung pada besarnya curah hujan. Salah satu metode yang dapat diaplikasikan dalam 

melakukan prediksi adalah Autoregressive Integrated Moving Average (ARIMA). Pada tahun 1970 Box 

dan Jenkins memperkenalkan metode ARIMA, yang merupakan metode analisa data dengan 

memperhatikan pola masa lalu kemudian membentuk suatu model peramalan (Nurissaidah. et al, 2018).  

Potensi sumber daya air di Taman Nasional Bantimurung telah dimanfaatkan untuk pengairan 

persawahan dan pemenuhan air bersih masyarakat kota maros-pangkep dan sekitarnya. Keberadaan 

wisata menjadi harapan masyarakat sebagai wahana pengentasan kemiskinan dan keterbelakangan 

melalui program pemberdayaan masyarakat. Desa wisata diharapkan mampu mengkomunikasikan 

berbagai bentuk kebutuhan untuk mewujudkan kesejahteraan masyarakat. Agar keberadaan desa wisata 

bisa memberikan kontribusi nyata dalam peningkatan kesejahteraan masyarakat maka diperlukan 

strategi bagaimana pengelolaan di objek wisata untuk itu kita dapat melihat dari potensi sumber daya 

air yang dimilikinya (Suharto, 2017). Potensi yang ada dikawasan Karst meliputi potensi sumber daya 

air yang banyak terkandung di dalam tanah, potensi biotik berupa adanya keragaman hayati di Kawasan 

ini, bahkan potensi social yang dapat dikembangkan (Hatma, 2006).  

Menurut Perdes No. 5 Tahun 2014 Desa wisata adalah wilayah pelestarian alam lingkungan 

ekosistem serta simpul budaya tradisional masyarakat dengan tidak menghambat perkembangan 

warganya untuk meningkatkan kesejahteraan hidupnya melalui usaha kepariwisataan. Menurut 

(Suharto. 2017) desa wisata adalah salah satu bentuk kelompk ekonomi dan sosial yang berada ditengah 

masyarakat yang diharapkan memberikan konstribusi secara ekonomi, sosial dan budaya melalui 

strategi pemberdayaan masyarakat itu sendiri. Wisata mandiri sendiri dimaksudkan sebagai daerah 

dengan potensi wisata dimana warga bisa mengelola dan mengembangkan sendiri pariwisata yang 

dimilikinya. 

Gua Leang Lonrong termasuk kedalam kawasan karst yang memiliki resiko kerusakan yang tinggi 

pada lingkungannya dan termasuk sebagai sumber air. Dengan adanya potensi dan kendala maka 

kawasan ini memerlukan adanya perlindungan atau pengelolaan yang baik, namun juga tetap 

diupayakan pengelolaan yang menguntungkan selama kegiatan yang dilakukan sesuai dengan potensi 

dan kondisi kawasan Gua Leang Lonrong tersebut. Salah satu yang dapat diupayakan dalam valuasi 

Gua Leang Lonrong adalah dengan pengembangan wisata itu sendiri. Oleh karena itu, Gua Leang 

Lonrong selain menampilkan wisata alam, seperti kolam permandian, flora, fauna dan sarana prasarana 

yang ada di Gua Leang Lonrong, begitupula dengan potensi gua yang dimiliki perlunya dikelola dengan 

baik. 
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B. METODE 
Penelitian ini merupakan penelitian menggunakan pendekatan deskriptif kuantitatif. Di mana 

dilakukan pengambilan data debit air harian enam tahun terakhir (2015-2020) Sungai Leang Lonrong 

yang diperoleh dari Balai Besar Wilayah Sungai Pompengan Jeneberang (BBWS). Selanjutnya 

melakukan Analisa-analisi perhitungan terhadap data yang telah diperoleh dengan mengacu pada teori-

teori yang telah dihasilkan dari studi literatur. Analisa perhitungan terhadap data adalah sebagai berikut. 

1. Analisis dilakukan terhadap data debit air selama 6 tahun (2015-2020) untuk menghitung besarnya 

ketersediaan air di Sungai Jeneberang Kawasan Gua Leang Lonrong. Dengan cara Menghitung nilai 

rata-rata debit air harian selama 6 tahun (2015-2020) kemudian membuat plot grafik yang dilakukan 

di Microsoft excel. 

2. Selanjutnya melakukan prediksi debit air pada sumber air di Sungai Jeneberang untuk meramalkan 

pola yang akan datang dengan pendekatan model ARIMA. Berikut ini adalah tahapan untuk 

memprediksi Debit Air di Sungai Jeneberang Kawasan Gua Leang Lonrong. 

a) Uji Stasioner data 

Langkah-langkah untuk mengetahui kestasioner data dengan menggunakan Software Eviews 

9 adalah sebagai berikut: 

1) Memasukkan data ke Eviews. Data yang di input adalah data dari tahun 2015-2018 

2) Untuk melihat kestasioneran data dalam varians dapat dilihat dari nilai probabilitas ADF 

dengan cara klik Data > View > Unit root test. 

3) Jika nilai probabilitas ADF lebih kecil dari 5% atau 0,05 berarti data sudah stasioner dan 

tidak perlu dilakukan differensiasi.  

4) Jika nilai probabilitas ADF lebih besar dari 5% atau 0,05 berarti data belum stasioner dan 

perlu dilakukan differensiasi.  

5) Untuk melakukan differensial, masuk kembali kemenu Data > View> Unit Root Test 

kemudian pilih first difference. 

b) Mencari model ARIMA 

Untuk menemukan model ARIMA yang sesuai dilakukan Langkah-langkah sebagai berikut. 

1) Untuk mendapatkan model ARIMA ada dua komponen yang perlu dicari terlebih dahulu 

yaitu nilai AR dan MA. Nilai ini dapat diperoleh dengan melihat bentuk Autocorrelation 

(AC) dan Parsial Autocorrelation (PAC) dari data yang telah stasioner. 

2) Untuk melihat bentuk AC dan PAC klik menu Series >View > Correlogram. 

3) Pilih jenis correlogram yang akan dibuat. Jika data tanpa differensiasi maka pilih level, jika 

sudah mengalami differensiasi maka pilih first difference begitu seterusnya klik OK. 

4) Dari grafik batang correlogram kita dapat mengidentifikasi nilai AR dan MA yang mungkin 

dijadikan model dengan melihat pada lag berupa nilai AC dan PAC yang melewati batas 

ambang kepercayaan 95% yaitu minimal dua bintang.  
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5) Jika lag pada AC yang memenuhi adalah 1 berarti model AR (1) memenuhi begitu 

seterusnya begitu pula dengan nilai PAC yang mengindikasikan model MA. 

c) Melakukan pengujian ARIMA  

Pengujian model ARIMA dilakukan seperti berikut. 

1) Langkah selanjutnya yang harus dilakukan adalah pemodelan ARIMA dengan menguji satu 

per satu nilai AR dan MA yang mungkin. Karena model yang muncul bisa jadi lebih dari 

satu maka perlu dilakukan pengujian model untuk mendapatkan model terbaik. 

2) Cara melakukan pemodelan ARIMA dengan mengklik menu Quick > Make equation > isi 

persamaan ARIMA yang diinginkan. 

3) Model yang layak digunakan adalah model yang memiliki nilai probabilitas t-stats lebih 

kecil dari 5% atau 0,05. Jika diperoleh beberapa nilai yang memenuhi syarat terbaik adalah 

model dengan nilai AR dan MA terkecil. 

d) Melakukan peramalan (prediksi) 

Setelah Langkah-langkah seperti diatas selesai, selanjutnya dilakukan prediksi dengan 

menggunakan model yang terbaik. Langkah-langkah untuk melakukan prediksi adalah sebagai 

berikut. 

1) Pilih menu model ARIMA yang telah dibuat > forecast 

2) Pilih static dan klik OK. 

 

C. HASIL DAN PEMBAHASAN 

Debit Air di Kawasan Gua Leang Lonrong 

Analisis grafik rata-rata debit air di Kawasan Gua Leang Lonrong dapat dilihat dari gambar 1 

memperlihatkan, bahwa selama 6 tahun (2015-2020) maka debit air terendah terjadi pada bulan 

September yakni 0,24 𝑚ଷ𝑠ିଵ atau 7,57 𝑚ଷ/tahun dan tertinggi pada bulan Januari yang mencapai 5,29 

𝑚ଷ𝑠ିଵatau 166, 85 𝑚ଷ/tahun. Terlihat pula, debit air berkurang mulai bulan Juli, Agustus, September 

dan Oktober. Bulan-bulan ini ditandai dengan musim kemarau di Kawasan Gua Leang Lonrong. Debit 

air mulai membesar pada bulan November sekitar 0,5 𝑚ଷ𝑠ିଵ atau 15,77 𝑚ଷ/tahun.   
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Gambar 1. Profil Debit Air Sungai Leang Lonrong tahun 2015-2020 

Tahap dalam melakukan prediksi dengan model ARIMA meliputi uji stasioner data dan penentuan 

model ARIMA terbaik. Menurut (Sari, R.P. et al, 2019) asumsi kestasioneran merupakan asumsi yang 

harus dipenuhi dalam memprediksi suatu data. Data stasioner merupakan suatu istilah yang berarti 

bahwa data berada dalam kesetimbangan di sekitar nilai 67 konstan selama waktu tertentu (Irma. et al, 

2017). Kemudian untuk penentuan model ARIMA terbaik menurut (Nurissaidah. et al, 2018) 

didasarkan pada suku AR dan MA yang memiliki signifikan paling rendah (nilai probabilitas lebih kecil 

dari 0,05). Itu sebabnya model ARIMA yang digunakan pada penelitian ini adalah model ARIMA 

(11,1,0) dimana nilai probabilitas suku AR dan MA lebih kecil dari 0,05. 

Hasil prediksi debit air dengan model ARIMA (11,1,0) untuk jangka pendek (tahun 2021) 

cenderung mengikuti pola pergerakan realitas yang terjadi, sedangkan untuk jangka panjang (tahun 

2022 dan seterusnya) pergerakannya relatif tidak mengikuti pola realitas yang ada. Menurut (Tias. et 

al, 2017) prediksi dengan ARIMA diasumsikan bahwa pola yang lalu akan terus berlangsung sampai 

masa mendatang. Ketika terjadi kenaikan atau penurunan pada data historis, maka hasil prediksi 

bergantung pada data historis tersebut. Itu sebabnya hasil prediksi tahun 2021 hingga 2024 yang 

diperoleh cenderung memiliki pola naik-turun karena mengikuti data historis di tahun-tahun 

sebelumnya yang juga mengalami naik turun dapat dilihat pada gambar 2, namun dengan begitu 

keberlanjutan ketersediaan air dapat dilakukan. 
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Gambar 2. Grafik Hasil Prediksi Debit Air di Kawasan Gua Leang Lonrong Tahun 2021 – 2024 

Menurut (Nurissaidah. et al, 2018) peramalan ARIMA dengan periode yang lebih sedikit akan 

memberikan hasil yang lebih akurat jika dibandingkan dengan peramalan dengan periode yang lebih 

panjang serta biasanya akan cenderung flat (mendatar atau konstan). Pola flat tersebut bukan berarti 

hasil peramalan tidak baik, namun dapat diketahui bahwa peramalan merupakan hal yang belum pasti 

kebenarannya sehingga dapat diasumsikan kondisi pada setiap hasil peramalan adalah stabil. Kondisi 

stabil artinya menganggap peristiwa yang akan terjadi masih berada dalam batas toleransi (dalam range 

tertentu yang masih dapat diterima) (Arsyad, M. et al. 2015), misalnya dengan mengasumsikan bahwa 

situasi dan kondisi cenderung konstan yang tidak di pengaruhi faktor eksternal, seperti curah hujan 

tinggi, kecepatan aliran, dan lainnya yang mempengaruhi debit air. 

 Menurut (Tias. et al, 2017) prediksi dengan ARIMA diasumsikan bahwa pola yang lalu akan terus 

berlangsung sampai masa mendatang. Ketika terjadi kenaikan atau penurunan pada data historis, maka 

hasil prediksi bergantung pada data historis tersebut. Itu sebabnya hasil prediksi tahun 2021 hingga 

2024 yang diperoleh cenderung memiliki pola naik-turun karena mengikuti data historis di tahun-tahun 

sebelumnya yang juga mengalami naik turun. 

 

D. SIMPULAN 

1. Daya dukung air ditentukan oleh kemampuan ketersediaan air maka diperoleh debit air 

berdasarkan analisis selama 6 tahun (2015-2020) kesediaan debit air sungai leang lonrong 

berdasarkan hasil pengolahan data yang diperoleh tidak sesuai dengan teori ini dikarenakan 

debit air sungai Leang Lonrong dapat berubah-ubah menurut curah hujan dan keadaan biofisik 

DAS. 

2. Hasil prediksi tahun 2021-2024 dengan model ARIMA di Kawasan Gua Leang Lonrong 

memiliki debit air tertinggi pada bulan Desember tahun 2024 sebesar 4,41 𝑚ଷ/s atau 139,1 
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𝑚ଷ/s atau 88,63 𝑚ଷ/tahun, ini menunjukkan bahwa keberlanjutan ketersediaan air selalu ada 

tiap tahunnya. 
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